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1 Introduction

1.1 Disk Images

Disk images are a wonderful way of packing entire folders or disks into a single file, either for trans-
port across the Internet or simply for backup. They are Apple’s preferred format for distributing
Mac OS X software. Unlike other formats, disk images preserve long filenames and Mac and Unix
metadata. They are compatible with all versions of Mac OS X; to access an image’s content, simply
double-click the image file in the Mac OS X Finder. The contents of a disk image can be accessed
in-place; unlike with archives, you can view and open the files on a disk image without spending the
time—or disk space—to uncompress the entire image. Apple’s Disk Utility can be used to create
disk images, but DropDMG is more powerful and easier to use.

1.2 DropDMG

DropDMG is the easiest way to create Mac OS X disk images. Just drag and drop a folder or
file, and DropDMG will create an image in .dmg, .img, or .smi format—or a Tar, Zip, or Stufflt
archive. Or, you can drag an existing image or archive file onto DropDMG to easily convert it
to any of the other supported formats. DropDMG supports encryption, segmented images, and
custom icons, and it can create images with rich-text license agreements in multiple languages.
There are many time-saving features such as temporary preferences when you hold down Option,
remembering recent folders, configurations to keep track of popular combinations of settings, and
the ability to create more than one image or archive at a time. All the options are available from
Automator!, AppleScript, and from the dropdmg command-line tool.

Here’s a brief rundown of DropDMG’s features:

e Create and convert images and archives (Tar, Zip, or Stufflt) simply by dragging and dropping
or by using a keyboard shortcut.

e Create .dmg images in many formats, as well as .img and .smi (self-mounting) images that
work on Mac OS 9 and . cdr master images that work on Windows. Compressed .dmg images
are smaller than Disk Utility’s but are fully compatible.

e Segment images, encrypt them, and encode them with BinHex, BZip2, GZip, or MacBinary.
e Include rich text license agreements, in multiple languages.
e Easily add a custom icon for the mounted image.

e Make images that auto-open when you mount them. Or make Internet-enabled images that
automatically expand when you download them.

e Hold down Option when creating an image to specify temporary options for that image
without changing the preferences.

"http://www.apple.com/macosx/features/automator/
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e Save named configurations; by switching between different configurations, you can instantly
recall different combinations of options.

e All options are available from Automator?, AppleScript, and the command-line dropdmg tool.
e Authenticate as an administrator to copy protected files.

e Create more than one image at a time to take advantage of dual processors, or just so you
don’t have to babysit the program when creating multiple images.

e Fix downloaded disk images so that they open and mount properly.

2 Setting Up DropDMG

2.1 Requirements

DropDMG 2.6 has been developed and tested on Mac OS X 10.3 and 10.4. It requires Mac OS X
10.3 or later.

DropDMG 2.2 is compatible with Mac OS X 10.2 and is still available?.

If Stufflt Expander? 9.0.1 or later is installed, DropDMG will be able to convert StuffIt archives to
other formats.

If Stufflt Deluxe® 7.0 or later (9.0.1 recommended) is installed, DropDMG will be able to convert
disk images and other kinds of archives to Stufflt X format. In addition, Stufflt Deluxe allows
DropDMG to convert more than one Stufflt archive at a time and to convert Stufflt archives
without opening the Stufflt Expander application. Recent versions of Stufflt Deluxe automatically
install the command-line stuff and unstuff tools that DropDMG requires; with older versions,
you will need to install these tools separately.

2.2 Installation

Double-click the DropDMG-2.6.dmg file to mount the DropDMG disk image. Then drag the
DropDMG application to your Applications folder.

To install the dropdmg command-line tool, choose Install “dropdmg” Tool from the DropDMG
menu. DropDMG will ask for an administrator password, as it needs to copy the dropdmg file to
the protected /usr/bin folder.

The DropDMG service will become available the next time you log in.

*http://www.apple.com/macosx/features/automator/
3http://c-command. com/downloads/DropDMG-2. 2. dmg
“http://www.stuffit.com/mac/expander/index.html
Shttp://www.stuffit.com/mac/deluxe/index.html


http://www.apple.com/macosx/features/automator/
http://c-command.com/downloads/DropDMG-2.2.dmg
http://www.stuffit.com/mac/expander/index.html
http://www.stuffit.com/mac/deluxe/index.html

2.3 Updating From DropDMG 1.x-2.x

DropDMG 2.6 is a free update for registered users of previous versions of DropDMG. Simply replace
your old copy of the DropDMG application with the new version. To take advantage of new features
in the dropdmg command-line tool, choose Install “dropdmg” Tool from the DropDMG menu.

2.4 Always Run With Root Access

Normally, if DropDMG does not have the privileges that it needs in order to create an image or
archive, it will prompt you to authenticate by entering an administrator password. This authenti-
cation lasts for a few minutes, or until you quit DropDMG (whichever happens first).

If you choose Always Run With Root Access from the DropDMG menu, DropDMG will
retain administrator access—even between launches—until you choose this command again (to
uncheck it). This saves you from the trouble of having to keep entering your password, and it
makes it easier to run DropDMG unattended (for example, as part of an automated, scheduled
backup). However, this is a potential security risk. Anyone with access to your copy of DropDMG
will be able to access and modify any file on your Mac.

3 Basic Operations

3.1 The Status Window

The top portion of the DropDMG Status window displays the current options that will be used
for creating images. The options may be changed using the Preferences window. You can also
Control-click on the striped portion of the window to quickly change common preferences using a
contextual menu.

806 DropDMGC Status

dmg, My License Agreement, next to source

Drop folders or files here or onto the DropDMG icon.

2004-11-27 10:55 AM Created "Sync Pro X 3_:5.|:|mg“
2004-11-28 04:07 PM Created "SpamSieve-2.2.4a3.dmg”
2004-11-30 01:30 PM Created "CDFinder 4.3.dmg"

2004-11-3001:37 PM Converted to “Python-2.4.dmg" o
% ________________________________________________________________________J



The bottom portion of the status window displays a log of the images that DropDMG has created,
converted, and fixed. Choose Clear Log from the File menu to erase the contents of the log.

3.2 Creating and Converting

DropDMG tries to determine what you want it to do based on the files or folders that you give
it. For example, suppose that you’ve set the preferences to create .dmg disk images. If you give
DropDMG a folder, it will create an image of the folder. If you give it a .zip, .tar.gz, or Stufflt
archive, it will convert the archive into a .dmg disk image. If you give it an image in another
format, DropDMG will convert it to .dmg format, using the options specified in the preferences.
Conversion can also be used to add or remove license agreements or encryption, or to segment or
join an existing image. If you give DropDMG a file that’s not an archive or image, DropDMG will
create a new image containing just that file.

When asked to create an image from a volume, DropDMG creates a special “device image” that is
an exact copy of the volume, not just its constituent files. If the volume was bootable, the image
may be burned to CD or DVD and the resulting disc will also be bootable.

When given multiple files or folders, DropDMG creates a separate image or archive for each. To
group multiple items into a single image or archive, move them into a new folder, and then drop it
on DropDMG.

So how do you “give” DropDMG a file or folder to work with? There are several ways:

3.2.1 Drag and Drop

Drag and drop one or more files or folders onto the DropDMG icon, either in the Finder or in the
Dock; or onto the top portion of the status window.

Hold down the Option key to choose a different configuration or options than the ones currently
selected.

3.2.2 Service

Select a file or folder in the Finder or Path Finder® and choose DropDMG or DropDMG (Ask
For Options) from the Services menu (inside the application menu). The ordinary DropDMG
command has a keyboard shortcut of Command-Shift-D. You can customize the keyboard shortcuts
in the Keyboard pane in System Preferences or using Service Manager”.

Shttp://www.cocoatech.com/pf . php
"http://www.blacktree.com/apps/servicemanager/index.html
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3.2.3 Automator Workflows

You can use the Automator® application in Mac OS X 10.4 to create workflows incorporating
DropDMG actions. Frequently used workflows can be accessed from a system-wide menu or saved
as droplets.

3.2.4 AppleScript

You can use AppleScript to automate DropDMG. For example:

-- create a new image
tell application "DropDMG"

create image from path "~/Desktop/folder" format NDIF compressed
end tell

-- convert an image
tell application "DropDMG"

set myImage to "~ /Desktop/image.img"

create image from path myImage format zlib compressed
end tell

See AppleScripting DropDMG for more information about the available AppleScript options.

3.2.5 Command-Line
In Terminal:
dropdmg -f ndif ~/Desktop/folder

Run dropdmg with no arguments to see a list of the available options.

3.2.6 Menu

Choose New from Folder/File. .. or Convert Image/Archive from the File menu. Unlike the
methods above, when you use one of these menu commands, DropDMG does not try to determine
whether you want to convert the source file/folder or create a new image/archive. It knows what
to do based on which command you chose.

Shttp://www.apple.com/macosx/features/automator/
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3.3 Fixing Disk Images

Sometimes a downloaded disk image won’t open because the Web server told the Web browser that
the disk image was a text file. DropDMG can fix such images by setting their type and creator
codes so that the Finder will open them. There are two ways to fix disk images:

e Drag and drop one or more disk images onto the DropDMG icon or onto the DropDMG
Status window while holding down the Control key.

e Choose Fix Image. .. from the File menu.

3.4 Getting Information About Disk Images

Choose Get Image Info... from the File menu to get information about a disk image, such as its
format and compression.

3.5 Mounting Images

You can mount an image on the desktop by double-clicking its icon. This works on any Mac OS X
machine, whether or not DropDMG is installed.

You may, however, want to mount an image at some other location in your local filesystem. This
can be done using the Mount Image At... command in DropDMG’s File menu. It will prompt
you for an image file and a folder, and then it will mount the image inside the folder.

Why would you want to do this? Perhaps you want to reduce desktop clutter. Or maybe you
know that another application will be looking for its files in a particular place. Maybe FileVault?
is overkill for you, but you still want to protect some of your files (using an encrypted disk image)
and make them available inside your Documents folder.

3.6 Verifying Disk Images

Choose Verify Image Checksum. .. from the File menu to verify that an image file is in working
order (not damaged).

3.7 Making Images With Background Pictures

When making an image from a folder, DropDMG copies to the image the background pictures and
view options of all the contained folders. It does not copy this information for the top-level folder

Shttp://www.apple.com/macosx/features/filevault/
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because Apple does not provide a way to do this. If the top-level background picture and view
settings on the image are important to you, you can set them as follows:

1. Drag the folder onto DropDMG and create a read-write image.
2. Mount the image in the Finder.

3. Set the background picture on the mounted image. Make sure the picture file you select
is saved somewhere on the disk image. Set the view options and arrange the icons the
way you want them.

4. Sometimes the Finder doesn’t save changes to the view options. It may help to create
and delete an empty folder on the image.

5. Unmount the image in the Finder using the Eject command in the File menu.

6. Drag the .dmg file onto DropDMG and convert it to read-only or a compressed format.

Some people like to save the background picture file in an invisible folder named .background, so
that it is not visible on the mounted image. This folder will not be visible in the Save window
of your graphics program. You can, however, type Command-Shift-G. This will let you enter the
path of the .background folder so that you can save the picture in it.

4 License Agreements

Disk images can include license agreements, which are displayed to the user whenever the image is
mounted. DropDMG lets you define multiple license agreements ahead of time. Each agreement
may be localized into multiple languages. You can choose which agreement (if any) to include with
an image. When you make an image, DropDMG will add that agreement, and all its localizations,
to the image file.

To manage your license agreements, choose Show Agreements from the License Agreements
menu. This opens the License Agreements window, which displays the agreements and localiza-
tions you have defined. The license agreements are automatically saved in DropDMG’s preferences
file.

To make a new license agreement, choose Add Agreement... from the License Agreements
menu. The created agreement will be empty. You can rename it by double-clicking the agreement’s
name. In order to type the text of the agreement, use Add Language... from the License
Agreements menu. This creates an entry in the License Agreements window for a new localized
variant. Note that only the English variant will be displayed on Mac OS 9.

To edit the text of an agreement, double-click on one of its languages in the License Agreements
window. This opens an editing window where you can type. You can view and edit multiple
localizations at once, if you want. The Edit menu contains commands for checking spelling and
text-to-speech.

10



License agreements can use multiple fonts, sizes, and styles of text. Beware, however, of using fonts
that are not built into Mac OS X, for the license agreement will look different if the user does
not have the fonts installed. Secondly, note that “synthetic” font traits will not be preserved. A
synthetic trait is a style for which you do not have a font. For instance, Mac OS X ships with normal
and bold variants of Lucida. Both of these work fine in license agreements. DropDMG will also let
you create a license agreement using italic Lucida, where the operating system synthesizes Lucida
Italic from regular Lucida, but the italic style will not be displayed when the image is mounted.

5 Configurations

At the top of DropDMG’s Preferences window is the configurations pop-up menu. The Save
Configuration As... command lets you save the current state of the Preferences window as a
named configuration. Choosing a configuration from the pop-up menu applies that configuration’s
settings to the Preferences window. Thus, you can have a configuration for each kind of image
or archive that you create and easily switch between the configurations depending on the task at
hand. The Edit Configurations... command opens a window that lets you view all of the saved
configurations. You can also use this window to rename configurations or delete them.

f.ﬂ 06 Edit Configurations

Archival .dmg ( Rename :'J
Distribution .dmg

Encrypted Stufflt ( Delete )
0S S-compatible

Zip

dmg, My License Agreement, icon, auto-open, net, next to

A
. ____________________________________________________J

The top of DropDMG’s status window shows the current configuration (if any), and you can
Control-click in the status window to switch to another configuration without having to open the
Preferences window.

11



6 Overriding the Preferences

Normally, when DropDMG is creating or converting an image, it uses the preferences shown in the
Preferences window. (See Preferences for explanations of the preferences.) Sometimes you may
wish to use slightly different preferences for a particular image. For instance, perhaps you usually
create .dmg images, but you sometimes need to make .img images for a friend who uses Mac OS
9. You could open the Preferences window, change the image format to .img, make the image,
and change the format back to .dmg. Or, you could save yourself some time by overriding the
preferences.

To use override the preferences, hold down the Option key when you drag a folder or image onto
DropDMG’s icon or the DropDMG Status window. That is, click on the icon and begin dragging;
then hold the Option key before you release the mouse button. After releasing the mouse button,
continue holding down Option until DropDMG displays a preferences sheet with the name of your
folder at the top. Any changes you make in this sheet will only affect that folder; they will not be
saved. Click the OK button to use the preferences as shown, or the Cancel button to not create
the image after all.

If you drop more than one item onto DropDMG, continue holding Option until a window and sheet
have opened for each item. With more than one preferences sheet open, you can use the Copy
to Others button to copy the settings on one sheet to the other sheets. In this way, you can
quickly override the preferences to create many similar images. As a shortcut, you can hold down
the Option key when clicking OK to dismiss all of the preferences sheets.

12



7 Preferences

een Preferences
Configuration: :Archival .dmg |+1 @
Format
: .dmg zlib-compressed (better compression) IH

| Encrypt using passphrase:

__| Limit segments to at most 100/ MB Confirm

Options

Encoding: ' None

|+1
|+1

License Agreement: r Mone

__Use custom icon for mounted image
" Auto-open image window after mounting

__ Internet-enabled (auto-copy instead of mounting)

Save
: MNext to Source |+1
" Prompt for names r Name Processing |-v1

Delete original after: | Creating W Converting

7.1 Format

DropDMG supports the following image formats:

13



.dmg zlib-compressed

zlib creates the smallest disk images, but they only work on Mac OS X 10.1 and later. This
is DropDMG’s recommended format for general use.

.dmg ADC-compressed

ADC images are a bit larger and slower than zlib images, but they work on all versions of
Mac OS X.

.dmg Read-only

Read-only images require Mac OS X and are larger than zlib- and ADC-compressed images.
However, when post-compressed with BZip2 or GZip they may end up smaller than the other
formats. Read-only images are also a good choice when the folder you are imaging contains
internally compressed files such as MP3s or JPEGs; in this case, using a compressed image
format takes significantly longer and does not save much more space.

.dmg Read-write

Read-write images can be mounted in the Finder and their contents modified. Read-write
images do not support license agreements. DropDMG creates read-write images slightly
larger than needed to hold all the files. This allows you to make minor modifications such as
repositioning icons and creating aliases to other files on the image. Once the image is exactly
the way you want it, you can use DropDMG to convert the read-write image into a compressed
one. Another use for read-write images is as a secure workspace. If you turn on encryption,
you can read and edit the files on the image as normal. However, when you unmount the
image, no one will be able to access the contents of the image without the passphrase.

.img NDIF-compressed
NDIF images work with Disk Copy 6.x on Mac OS 7, 8, and 9, as well as on Mac OS X.

They have resource forks and so must be encoded with a utility such as Stufflt, MacBinary,
or BinHex before they are shared on the Internet. NDIF images do not support encryption
and they are limited to 2 GB.

.img NDIF read-only

This is an uncompressed NDIF image whose contents cannot be modified.

.img NDIF read-write
This is an uncompressed NDIF image whose contents can be modified. Read-write images do
not support license agreements.

.smi NDIF-compressed

Self-mounting NDIF images (.smi files) may be used on Mac OS 7, 8, and 9 systems that do
not have Disk Copy installed. Additionally, self-mounting images are the only type that can
display license agreements on Mac OS 9.

.sitx Stuffit X Archive

Stufflt X generally produces the smallest (most tightly compressed) files, but it slower than
the other formats and Stufflt Expander is required to to expand the archives. Like .dmg disk
images, this format preserves all Mac and Unix metadata.

14



.tar Tape Archive

Tar is a common Unix format. It is an uncompressed format, so for the smallest file sizes you
should choose either the GZip or BZip2 encoding option to create a compressed .tar.gz or
.tar.bz2 file. DropDMG only supports Tar archives on Mac OS X 10.4 and later, because
earlier versions of the OS cannot create (or expand) Tar archives that preserve Mac resource
forks and other metadata. To expand a Tar archive, simply double-click it in the Mac OS X
10.4 Finder.

.zip Zip Archive

Support for the Zip archive format is built into Mac OS X 10.3 and later. It is also compatible
with unzipping utilities on Windows. This format preserves resource forks and Mac metadata
when expanded by the Finder. Do not expand the files using Stufflt Expander, because it does
not preserve the Unix permissions and ownership. Zip archives do not support encryption or
segments.

.cdr DVD/CD-R Master

Master images are uncompressed, so they are not good for archival. They are useful, however,
for storing and transferring the contents of CD or DVD and can be read by both Mac and
Windows disc-burning software.

7.2 Encrypt using passphrase

Encrypted images require a passphrase for access. They work on Mac OS X 10.1 and later. En-
crypted images are much slower to access than unencrypted images. DropDMG uses Apple’s im-
plementation of the AES-128 algorithm!®. Encrypted Stufflt archives use Allume’s implementation
of the AES-256 algorithm.

You can enter a passphrase in the text field to have DropDMG use that passphrase for all images
and archives (until you change it). DropDMG stores the password securely in the system keychain.

A blank image passphrase will cause DropDMG to prompt you to enter a passphrase when the
image is created. A blank Stufflt passphrase is the same as not having a passphrase.

To verify the passphrase, click the Confirm button and re-enter it. DropDMG will tell you whether
the passphrase that you typed matches the one that was previously entered.

7.3 Limit segments to ___ MB

This option lets you set a maximum size for image files or Stufflt archives. If an image requires
more space than the set limit, DropDMG will split it into two or more files.

To mount a segmented image or expand a segmented archive, open the first file of the segments.
The segments will be joined automatically so long as they are all in the same folder.

Ohttp://csrc.nist.gov/encryption/aes/
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To split an existing image into smaller pieces, set the segment size and then drag the image file
onto DropDMG’s main window.

7.4 Encoding

NDIF and self mounting image files cannot be directly transmitted on the Internet because they
have resource forks''. BinHex and MacBinary encoding convert the image to a data fork-only
file that can be safely uploaded to Web and FTP servers, even using software that’s improperly
configured or not Mac-savvy. MacBinary produces smaller files than BinHex, but some older
software can only decode BinHex.

If you choose an encoding other than None, DropDMG will encode images so that you end up
with a .hqgx file, a .bz2 file, a .gz file, or a .bin file. If you select BZip2 or GZip, the image will
be compressed a second time, in addition to the zlib/ADC/NDIF compression that is intrinsic to
the image format. This will make the resulting file a bit smaller.

Some Web servers have trouble handling plain .dmg files, so that when people download them they
open in the Web browser instead of mounting automatically. If you administer an Apache-based
server, you can fix this by adding this line:

AddType application/x-apple-diskimage .dmg
or this line:
AddType application/octet-stream .dmg

to your .htaccess file. If you cannot do this on your server, you can use encoding to eliminate
the problem, at the expense of an extra decompression step after downloading (usually using Stufflt
Expander or OpenUp).

BZip2 is slower than GZip but compresses better. MacBinary offers no compression at all, so it is
fast. BZip2 and GZip are disabled for NDIF images because they do not work with files that have
resource forks.

If you use encoding in combination with segments, DropDMG will encode each segment of the
image. Some segments may compress better than others, so it is normal for the segments to be of
unequal size after encoding.

7.5 License Agreement

If you choose a license agreement other than None, a license agreement will be displayed each time
the image is mounted. Use the pop-up menu to select the license agreement you want included. This

"http://www.macdisk. com/macforken.php3
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option is disabled if you have not entered any license agreements. To add a license agreement, choose
Show Agreements from the License Agreements menu. Then choose Add Agreement... to
add an agreement and Add Language. .. to add at least one language.

7.6 Use custom icon for mounted image

Normally when a disk image is mounted, it shows up on the desktop with a plain white icon that
looks like a hard drive. With this option checked, DropDMG will customize the icon based on
the contents of the image. If the top level of the image contains an application, DropDMG will
badge the application’s icon onto the white drive icon. Or, if you create an image from a single file,
DropDMG will badge that file’s icon onto the drive.

To use a custom icon of your own design, save your icon at the top level of the folder from which
the image will be created. The name of the icon file must be .VolumeIcon.icns, and the file must
be in icns format. The easiest way to save an image in this format is to use the Convert Graphic
to “.Volumelcon.icns”... command in DropDMG’s File menu. This lets you convert an image
in another format (PNG, PDF, etc.) into icns format and use the proper filename.

7.7 Auto-open image window after mounting

With this option selected, DropDMG will make images that automatically open their root folder
when mounted. That is, when you double-click the image in the Finder, its window will open. This
is especially useful for images that you will be distributing to other users. Depending on how their
Finders are configured, they may not see the image’s icon appear on the desktop; therefore, making
the image window auto-open provides a superior user experience.

7.8 Internet-enabled (auto-copy instead of mounting)

When an Internet-enabled!? disk image is downloaded by Safari (and Safari’s Open “safe” files
after downloading preference is checked), it is automatically expanded into a folder and the

2http://developer.apple.com/documentation/DeveloperTools/Conceptual/SoftwareDistribution/index.html
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image file is moved to the trash.

On Mac OS X 10.2.2 through 10.2.8, this happens whenever an Internet-enabled disk image is
mounted (by any program).

On earlier versions of Mac OS X, Internet-enabled disk images are treated just like other disk
images.

7.9 Save

You can choose to have images created in the same folder as the source folder (Next to Source),
or specify a folder where images should be saved (by choosing Other. .. or dragging a folder onto
the preferences window). If you specify a destination folder that’s contained by the source folder,
DropDMG will revert to its default behavior of saving the image next to the source folder. The
Ask Later option causes DropDMG to ask you, for each operation, where to save the image or
archive.

The bottom portion of the pop-up menu lists recent folders and favorite folders. Recent folders
are the last 10 folders that you’'ve chosen. Favorite folders are always shown in the menu, even if
you have not used them recently. To make a recent folder into a favorite folder, find the folder’s
alias in “/Library/Application Support/DropDMG/Recent Folders. Select the alias and open
the Finder’s Get Info window. Then click the Locked checkbox.

7.10 Prompt for names

With this option selected, DropDMG will ask you to enter the name of the image file it will create
and the name of the volume that will appear on the desktop when you mount the image. DropDMG
will automatically add the proper filename extension (.dmg, .img, or .smi) to the image name. It
may also truncate the names you enter if they would be too long for the Mac’s volume and filename
limits.

With this option deselected, DropDMG will assign the image and volume names based on the name
of the folder being imaged.

7.11 Append Current Date

This option adds the current date (in the YYYY-MM-DD format) to the end of the name of the
output disk image or archive.
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7.12 Sanitize for Servers

This option processes the name of the output disk image or archive so that it does not contain
any spaces, accented or foreign characters, or certain punctuation marks. This makes it possible to
upload it to a Web or FTP server and then access it using a URL that contains no percent escape
sequences.

7.13 Delete original after Creating or Converting

If you select one of these options, DropDMG will move the source folder, image, or archive to the
trash after it has finished making the image.

8 AppleScripting DropDMG

AppleScript!? is a great way to automate your Mac. You can view DropDMG’s AppleScript dic-

tionary by dragging and dropping the DropDMG application onto Apple’s Script Editor. The
create image command lets you make images from folders, files, or other images. Whenever you
use create image, you must always include the following parameter:

from path
This can be a POSIX path or an alias to a folder or file.

The remaining parameters are optional.

configuration name

Instead of specifying all the parameters in AppleScript, you can create a named configuration
in DropDMG’s preferences window, and then just specify the name of the configuration in
the script, as a string. If you do this, all of the options below, except always create, base
name, and volume name are ignored. This is because the other options are specified as part of
the configuration. If you specify the empty string ("") as the configuration name, DropDMG
uses whichever options are currently set in the Preferences window.

always create

Normally, DropDMG will automatically determine whether to convert the source item to
another format or to create a new image/archive containing the item. If conversion is possible,
it will convert; otherwise, it will create. This option lets you tell DropDMG to create a new
image/archive, even if conversion is possible. It should be either true or false. If no value
is specified, DropDMG will automatically decide whether to convert or create.

http://wuw.apple.com/applescript
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format
This corresponds to the Format preference. Accepted values are: zlib compressed, ADC
compressed, read only, read write, NDIF compressed, NDIF read only, NDIF read write,
self mounting, StuffIt X, tar archive, zip archive, and master. If no format is speci-
fied, DropDMG will choose z1ib compressed.

encryption
This corresponds to the Encrypt using passphrase preference. It should be either true or
false. If no value is specified, DropDMG will make the image unencrypted.

passphrase
If encryption is specified, you may also specify the passphrase with which to encrypt the
image or archive.

segment size
This corresponds to the Limit segments to ___ MB preference. It should be a number, zero or
greater, representing the number of megabytes per segment. If the value is zero or omitted,
DropDMG will not segment the image.

encoding
This corresponds to the Encoding preference. Accepted values are: none, binhex, bzip2,
gzip, and macbinary. If no encoding is specified, DropDMG will choose none.

license agreement name
This corresponds to the License Agreement preference. If the name is omitted or the empty
string (""), DropDMG will not include a license agreement.

custom icon
This corresponds to the Use custom icon for mounted image preference. It should be either
true or false. If no value is specified, DropDMG will not use a custom icon.

auto open

This corresponds to the Auto-open image window after mounting preference. It should be
either true or false. If no value is specified, DropDMG will not make the image auto-open.
This option is ignored when creating an image by converting.

internet enabled

This corresponds to the Internet-enabled (auto-copy instead of mounting) preference. It

should be either true or false. If no value is specified, the image will not be Internet-
enabled.

destination

This corresponds to the Save preference. This can be a POSIX path or an alias to a folder.
If the destination is omitted, DropDMG will use the folder that contains the source folder or
image. If the destination is the empty string (""), DropDMG will prompt you to choose a
destination.
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base name

This is the name of the image to create, without the .dmg, .img, or .smi extension. If the
base name is omitted or the empty string (""), DropDMG will use the name of the source
folder or image.

volume name

This is the name of the mounted image volume. If the volume name is ommitted or the empty
string (""), DropDMG will use the name of the source folder. This option is ignored when
creating an image by converting.

append current date

This corresponds to the Append Current Date preference. It should be either true or false.
If no value is specified, DropDMG will not append the date.

sanitize for servers

This corresponds to the Sanitize for Servers preference. It should be either true or false. If
no value is specified, DropDMG will not modify the name.

delete original

This corresponds to the Delete original after Creating or Converting preference. It should be
either true or false. If no value is specified, DropDMG will not delete the source folder or
image.

just package contents

Some Mac OS X files, such as a applications, are actually special folders called packages. The
system presents packages to the user as a single file, but they’re actually stored on disk as
folders. Normally, when DropDMG makes an image from a folder it copies the contents of
the folder into the image; that is, the mounted image behaves just like the original folder did.

Since packages are folders, you can make images of them with DropDMG. However, if
DropDMG proceeds as usual, when you mount an image that was created from a pack-
age, the Finder will think that the mounted image is a package. It will show the package icon
instead of the disk image icon, but it won’t let you double-click the mounted image to access
the package (e.g. launch the application). You might think that you could drag the mounted
image to your hard disk to launch the application from there, but the Finder will create an
alias instead (unless you know to hold down Option).

Therefore, by default, DropDMG recognizes when you are imaging a package and gives you
a disk image with the package inside it, instead of making an image of the package. To
disable this feature, and thus have DropDMG treat all folders consistently, pass true for this
parameter.
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9 Frequently Asked Questions

9.1 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number by
clicking the Lost Your Serial Number? button in DropDMG’s Purchase window.

9.2 How can I burn disk images to CD/DVD?

Use Apple’s Disk Utility program, which is in the Utilities folder in the Applications folder.

9.3 Why does DropDMG try to connect to dreamhost.com when it starts up?

It’s checking to see whether there’s a newer version of DropDMG available. You can disable this
feature from the Software Update window that’s accessible from the DropDMG menu.

10 Purchasing and Support

10.1 Contact Information

You can download the latest version of DropDMG from the DropDMG Web site'. Questions about
DropDMG may be sent to dropdmg@c-command.com!®. I'm always looking to improve DropDMG,
so please feel free to send any feature requests to that address.

To make sure that you have the latest version of DropDMG, you may wish to subscribe to the
DropDMG News mailing list'6. The traffic on this list is very low, only one message per new
version of DropDMG.

10.2 Purchasing

DropDMG has a free trial period that lasts for 30 days or 20 launches, whichever is longer. To use
DropDMG beyond the demo period, you must purchase it. This entitles you to free updates and
support.

“http://c-command. com/dropdmg/
Bpailto: dropdmg@c-command. com
http://c-command. com/dropdmg/support
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To purchase, choose Purchase. .. from the DropDMG menu. You can use the Instant Purchase. . .
button to enter your billing information from within DropDMG or use the Web Purchase. .. but-
ton to enter it from your Web browser.

Soon after paying, you'll receive an e-mail with your serial number. If you used Instant Purchase. . .,
you're done. If you used Web Purchase. .., enter the name and serial number from the e-mail
into the Purchase window and click Personalize. If you need to re-install DropDMG, you can
simply re-enter your name and serial number and click Personalize; there’s no need to purchase
again.

If you purchased DropDMG but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up
your order information.

A license for DropDMG is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your PowerBook; you can then use it on either machine, provided that no one is
using it on the other machine.

10.3 Legal Stuff

DropDMG and this manual are copyright (©) 2002-2005 by Michael J. Tsail?. All rights reserved.

Please distribute the unmodified DropDMG-2. 6 . dmg file on the Web, LANSs, compilation CD-ROMs,
etc. Please do not charge for it (beyond a reasonable cost for media), or distribute the contents of
the image file in isolation. Do not distribute your serial number.

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

DropDMG is a trademark of Michael Tsai. Mac is a registered trademark of Apple Computer. All
other products mentioned are trademarks of their respective owners.

The following open-source components are used in DropDMG:

Regular expression support is provided by the PCRE'® library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

17mailto:mjt@c-command.com

Bhttp://wuw.pcre.org
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11 Version History

2.6—April 29, 2005

Works with Mac OS X 10.4 (Tiger).
DropDMG now has an Automator'® action.

Can now create Mac OS X 10.4 Tar archives (.tar, .tar.gz, .tar.bz2) that support Mac
resource forks.

Added Append Current Date and Sanitize for Servers name processing options.

Can now create uncompressed read-only and read-write NDIF .img disk images.
DropDMG is smarter about picking which file to use to create a custom icon.

Added configuration name AppleScript parameter.

Fixed bug where images sometimes weren’t created large enough to hold all the files.
Fixed bug where script errors were only reported in abbreviated form.

Added Edit Configurations to the DropDMG menu.

Added keyboard shortcuts for opening the Edit Configurations window and for saving
the current configuration.

Worked around the OS to prevent DropDMG from sometimes being dropped from the
Services menu.

Window order of the Preferences window is preserved when closing the Configura-
tions window.

Updated to eSellerate Engine 3.6.1.
Improved serial number name entry.

The Apple Help is now multiple linked pages, rather than a single page, so you can now
use Help Viewer’s search box.

2.5.3—February 7, 2005

Fixed bug where some valid files weren’t choosable in the open dialogs.
Update Czech localization.

Improved name and serial number entry.

2.5.2—January 24, 2005

Fixed bug where the volume permissions would be incorrect when making an image
directly from a file.

Added French localization.
Updated Czech localization.

2.5.1—January 11, 2005

Fixed bug where the BinHex and MacBinary encoders didn’t preserve non-ASCII file-
name characters.

Yhttp://www.apple.com/macosx/features/automator/
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Fixed bug where special handling of file packages was sometimes disabled.

When there are many simultaneous operations, DropDMG will queue some of them.
This improves performance and works around some hdiutil limitations.

Added Always Run With Root Access option.

When prompting for file and volume names, DropDMG is smarter about when to remove
the file extension in its suggested name.

Relaxed requirement that the source item’s containing path doesn’t contain a slash
(colon).

Now sets the owner and permissions of the disk image root to match the source folder.
Added help button to the preferences window.
Added Cgzech and Italian localizations.

2.5—December 7, 2004

Can now create archives in Panther’s Zip format; can convert Zip archives to images and
vice-versa.

DropDMG can now create Stufflt X archives, convert Stufflt archives to disk images,
and vice-versa.

Can now convert .tar, .tgz, .tar.gz, and .tar.bz2 archives to disk images (as well
as to .zip and .sitx).

Added support for .cdr (DVD/CD-R master) images.
DropDMG can create a custom icon for the mounted image.

You can now save named Configurations of DropDMG’s preferences. By switching be-
tween different configurations, you can instantly recall different combinations of options.

When you ask DropDMG to create an image from a volume, it automatically creates a
device image, an exact copy of the volume, which is bootable (if original volume is).

DropDMG now has a system service, which lets you easily create images/archives from
items selected in the Finder, without DropDMG being open or in the Dock.

Added Mount Image At... command, which lets you mount images at arbitrary loca-
tions in the filesystem, rather than on the desktop.

Add Ask Later option, which makes DropDMG prompt you for a destination folder
each time it needs to save an image or archive.

Added Confirm button to let you verify a passphrase after typing it.

DropDMG can now process multiple commands from AppleScript or the command line
at the same time.

Uses much less memory when computing folder sizes.

Launches faster.

The license agreement editor now supports find and replace.

The log and image info windows now support the Find command.

Lots of minor interface tweaks (window zooming, folder abbreviations, checkbox and
button enabling etc, keyboard shortcuts, new window manipulation menu commands.).
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e When creating encrypted images, the passphrase is now sent to hdiutil securely using
a pipe instead of on the command line.

e A Cancel button is now available when you’re prompted to enter image and volume
names.

e When creating a segmented image or archive, the segments are now placed in a newly
created folder.

e Normalizes serial number case when personalizing, to make it less error-prone.

e You can hold down the Option key when clicking OK to dismiss multiple temporary
preferences sheets at once.

e If the chosen destination folder is read-only, DropDMG now prompts for a new destina-
tion folder rather than aborting with an error.

e When you try to delete a license agreement, DropDMG now shows an alert sheet to
make sure that’s what you really meant.

e The returning immediately AppleScript parameter is no longer needed and has been
removed. If you want the AppleScript command to return before the operation is com-
plete, use a standard AppleScript with timeout block.

e The create image AppleScript command now returns the path of the created im-
age/archive. The command-line tool prints the path to standard output.

e The When Imaging a Package option has been removed from the preferences, but is
still available via AppleScript and the command line.

e When creating an image, DropDMG now preserves ownerships and permissions, rather
than just permissions. (This will not be evident unless you uncheck Ignore ownership
on this volume after mounting the image.)

e Fixed bug where you’d have to authenticate more often than necessary.

e Fixed bug where relative paths did not work with the dropdmg tool’s --destination
switch.

e Fixed bug where top-level symlinks were resolved instead of being copied as links.

e Fixed bug where it was possible to rename a license agreement, giving it the same name
as another agreement.

e Fixed bug where DropDMG would sometimes return a “permission denied” error when
calculating the space necessary to image a folder. Now, it will instead prompt for an
administrator password.

e Fixed bug where sometimes you’d be prompted for a password after already entering
one in the preferences sheet.

2.2—October 16, 2003

e Added dropdmg tool for creating images from the command-line.

e You can now create an image from a file by dropping it on DropDMG; you no longer
have to “wrap” the file in a folder.

e You can now specify the passphrase for an encrypted image via AppleScript.

e Can save a passphrase in the system Keychain, so that you can encrypt multiple images
using the same passprhase, without having to keep typing it.
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Lets you authenticate as an administrator to copy protected files to an image.
Images can now be encoded with BinHex.

You can now drag a file or folder onto the preferences to set the destination.
License agreements can use non-roman characters.

Added Get Image Info... command.

Added Verify Image Checksum. .. command.

Added crash reporter.

Added software update version checker.

Faster MacBinary encoding.

Uses less memory when dealing with lots of files.

The destination pop-up menu now includes icons.

Rather than nagging when unregistered, DropDMG now has a 30-day/20-launch trial
period.

Fixed bug that caused an error when creating more than one self-mounting image simul-
taneously.

Fixed bug where DropDMG never prompted for volume and image names when you
used a temporary preferences sheet.

DropDMG now requires Mac OS X 10.2 or later.

2.1.1—July 21, 2003

Fixed bug where converting a .dmg file created by Disk Copy to .img or .smi caused
the .dmg file to remain in use so that it couldn’t be deleted, or its volume ejected.

Adding license agreements to images now works on Panther.

Fixed open/save dialog prompts to be more in line with the Aqua Human Interface
Guidelines.

2.1—April 24, 2003

Remembers recent and favorite destination folders.

Can create Internet-enabled disk images.

Simplified the drag modifiers, the preferences window, and the scripting interface.
Can move the source folder to the trash after creating an image.

Can choose the destination folder when converting.

You can now specify preferences overrides using one sheet per image, rather than a single
modal dialog.

You can now set the volume name and image name from the scripting interface.

Added a returning immediately scripting parameter. This lets you control whether
the script waits for DropDMG to finish creating the image.

You can now use tildes in paths when scripting DropDMG.

Suggests localized image names, when possible, and omits hidden extensions, so that
you don’t end up with, e.g., a .app.dng file.
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The license agreement editor is much more responsive.
You can set the encoding from the DropDMG Status window’s contextual menu.
Can now encode .dmg images with MacBinary.

Updated the MacBinary encoder for compatibility with Apple’s JDK 1.4.1. (In the
latest JDK, Apple removed support for JDirect, which the old MacBinary encoder relied
upon.)

Fixed bug where DropDMG couldn’t image a folder with more than 100 or so top-level
items.

Worked around problem where some .dmg images created with Disk Copy could not be
converted to .img or .smi.

Fixed license agreement assertion failure bug.
DropDMG will no longer let you quit while an image operation is in progress.

The agreement editor window zooms to the width of the text field that Disk Copy will
use to display the agreement when the image is mounted.

When you drag something over the DropDMG Status window, its instructional text
changes to tell you the meanings of the modifier keys.

The DropDMG Status window is closable (if you register).
License agreements remember their window positions across renames.
The License Agreements window is printable.

The DropDMG Status window zooms to a reasonable width instead of the whole
screen.

The DropDMG Status window summary shows more of the current preferences.
The progress bar is finer-grained.

The key equivalent for Delete Selection is Command-Delete instead of Command-D.
Better error messages.

DropDMG is better about picking fresh names for its temporary files.

The Registration window is smarter about ignoring whitespace and control characters
that can be introduced when pasting in a serial number.

2.0—October 23, 2002

Converts dropped images to the format specified in the preferences when you hold down
Control-Shift.

Hold down Option when dropping a folder or image to specify settings to be used for
that item (temporarily overriding the preferences).

Makes self-mounting NDIF images (SMIs). This is the only kind of image that supports
license agreements on both 9 and X.

Creates smaller zlib-compressed images when running on 10.2 and later. (The images
are still compatible with 10.1’s Disk Copy.)

You can now choose to post-compress with BZip2 instead of GZip. BZip2 is slower than
GZip but creates smaller files.
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e Improved the layout of the preferences window.
e Faster at copying files to the image when running on 10.2 and later.

e Worked around 10.2 bug that caused errors when a file or folder name contained a slash
(as shown in the Finder).

e Worked around OS X bug that prevented copying files larger than about 1 GB.
e New application icon.

e Compiled with GCC 3.

e No longer calls thread-unsafe parts of Carbon from child threads.

e Prevents the user from making a read-write image with a license agreement, rather than
stopping midway through with an error message saying that this wasn’t possible.

e The status window no longer looks as though it will accept the drop when you try to
drop a .dmg file that doesn’t need metadata fixing.

e Changed File menu text and keyboard shortcuts to more closely match 10.2’s Disk Copy.
e The about box and registration window now use the design first seen in SpamSieve.

e The log no longer uses the large system font under 10.2.

e Better error message if you try to image the startup volume.

e Fixed bug where images with license agreements contained duplicate styl resources.
1.7.3—August 17, 2002
e Fixed bug that could make DropDMG crash when you clicked the Include license
agreement checkbox.

e The spelling commands now have the standard keyboard equivalents.

e The Preferences. .. keyboard equivalent has been changed to Command-,.
1.7.2—August 15, 2002

e Removed spurious error message when changing the attributes of text in a license agree-
ment.

1.7.1—August 12, 2002

e The user interface no longer gets out of sync when you modify license agreements.

e Changes to the segment size take effect immediately; you no longer have to type Tab or
Return to commit them.

e The status window updates faster.
1.7—August 12, 2002
e Added support for license agreements. License agreements support rich text and may

be localized.

e The image destination path is now stored abbreviated with a tilde, if possible. This
should help people who have multiple boot partitions.

e The log is printable.

e Finer-grained progress bar and status text.
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If adding the requisite filename extensions would make the requested image name longer
than the limit, DropDMG will now quietly truncate the name rather than stopping with
an error.

NDIF images are now created with filenames of 31 characters or less, so that there won’t
be any name mangling when they’re viewed in Mac OS 9.

DropDMG now truncates .dmg volume names to 62 characters and .img volume names
to 27.

Fixed bug where DropDMG could deadlock after certain kinds of errors.

Fixed bug where DropDMG sometimes didn’t detect filename collisions until after it
started making the image.

Fixed bug where DropDMG would overwrite pre-existing .dmgpart files if the first seg-
ment was not present and the newly created image happened to have the same name.

Renamed some File menu commands.

1.6—July 15, 2002

Option to make images auto-open. When you mount an image, its window opens in
the Finder. Previously, there might have been no visual indication that the image had
mounted, depending on how the user’s Finder preferences were set.

The status window has a contextual menu for quickly changing common preferences.

You can optionally set the names of the image file and volume, instead of having them
based on the name of the folder.

Documentation is now included in Apple Help (HTML) format as well as PDF.
Contains a menu command for clearing the log.

No longer fails when copying files for which the user only has read privileges. Previously,
DropDMG would copy the file and permissions and then report a permissions error when
it tried to set the catalog information of the copy, which wasn’t writable.

The radio buttons for selecting where the image will be saved are no longer linked to
the image destination text field. That is, tabbing of the text field no longer affects the
radio button’s selection, making the preferences more friendly for keyboard navigators.

1.5—May 2, 2002

Multi-threading—DropDMG can create more than one image at a time, and the interface
remains responsive.

Can divide large images into multiple segments of fixed size.

Creates uncompressed read-only images, which often compress better with GZip than
internally-compressed image files do.

Creates read-write images.

Encodes Mac OS 9 .img images with MacBinary so that they can be transferred on the
Internet.

The status window displays a log that shows all the completed operations and errors.

The status window now shows all the format options that are in effect.
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Faster copying of Mac metadata.

Worked around Apple bug that sometimes caused errors when creating large images.
hdiutil crashed when expanding sparse images.

Fixed bug where DropDMG mistakenly resolved symlinks when copying Mac metadata.
This had caused some metadata not to be copied, and also caused image creation to fail
if the user didn’t have write access to the original file.

Fixed regression where DropDMG sometimes didn’t complain when the destination
folder was inside the source folder.

Tries several times to eject images, rather than giving up immediately.
More detailed reporting of file copy errors.
More accurate reporting of what state the image creation process is in when errors occur.

Mailing list for version announcements has a Web interface.

1.3.1—March 11, 2002

You can now create images by dragging and dropping folders into the status window.
The status window’s indication of the progress is more accurate.
Fixed regression in which images couldn’t be created on non-boot volumes.

Fixed regression in which images couldn’t be created in ~/Desktop if the destination
folder had never been manually set.

1.3—February 25, 2002

You can now choose whether images are saved next to the source folder, or in a user-
defined folder.

Volume images are now created in ~/Desktop by default (instead of /Volumes).

Resolved problem in which DropDMG tried to replace invisible system files on the image,
if the source folder contained items with the same names.

The format parameter is now optional when creating images with AppleScript.
Notifies the system after fixing an image’s type and creator.

Fixed bug in which DropDMG would report the wrong file as the cause of a copy error.
The keyboard loop in the Preferences window should work again.

The status window no longer flickers when the program first opens.

The distribution is smaller, since the manual uses fewer images.

1.2.1—February 11, 2002

Uses Carbon to preserve Finder info (e.g. the locked, stationery, and custom icon bits)
when copying files.

1.2—February 3, 2002

All options are now available from the scripting interface.
No longer requires Mac OS X’s optional “BSD Subsystem” installation.
Optionally post-compresses DMGs with GZip.
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Fixes type and creator codes of DMGs.

Preferences window is easier to use; now, enablement is only tied to the Image Format
radio buttons.

Capitalizations now follow the Aqua Human Interface Guidelines.

1.1—January 28, 2002

Supports ADC and NDIF compression for compatibility with Mac OS 10.0.x and Mac
OS 9, respectively.

Supports encrypted compressed images in the zlib and ADC formats.

Optionally detects packages so that you end up with a mounted image containing the
package instead of a mounted image that the Finder thinks is a package.

Copies locked files to images (instead of stopping with an access error).

Images’ logical sizes are smaller; this should slightly reduce their physical sizes and
reduce mount times.

Accepts drops of all file types (including packages); if DropDMG doesn’t know how to
handle a dropped file it will just ignore it.

The Make Image From Folder. .. menu command lets you choose packages and sub-
folders of packages (instead of just vanilla folders).

Minor UI tweaks.

1.0—January 21, 2002

First public release.
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